
WinJammer Player
WinJammer Player is a program which plays MIDI songs.    It allows you to create "Albums" 
of songs which will be played in sequence.    Because WinJammer Player does all this 
playing in the background, you can now listen to your favorite songs while you do other 
things.    If you are running Windows in extended mode (386 mode), WinJammer Player will 
even play while you are in a DOS session.
WinJammer and WinJammer Player are not a free programs.    They are distributed under 
the Shareware concept.    This allows you to examine the program, and to determine 
whether it is of worth to you.    If you find the program useful, and are going to keep using it
after the evaluation period, you are under both a legal and moral obligation to register it.    
The evaluation period for WinJammer is 30 days. Please review the help topic Registration 
for more information.
This index contains a list of all Help topics available for WinJammer Player.    For information 
on how to use Help, press F1 or choose Using Help from the Help menu.
Quick Start Quick start help for first time users.
Commands Information on all available commands.
Keys List of the keys used in WinJammer Player.
Registration How to register WinJammer.
WinJammer Professional Information on WinJammer Professional.



Quick Start
Welcome to WinJammer Player.    We will try to get you going as fast as possible by 
describing how to play the sample songs.    The sample songs are all set up for the General 
MIDI specification, so you may have to revoice them using WinJammer before trying to play 
them here.
Configuration
Before you can play a song the MIDI hardware must be configured.    The File Configure 
command is used to do this.    If you've already done this with WinJammer, you don't have 
to do it again.
Creating an Album
WinJammer Player deals with lists of songs to play, called Albums.    It is easy to build an 
album.
1. Clear Album.    The list labeled Songs shows the contents of the current album.    It is 
empty when the program is started.    If it is not empty now, use the File New command to 
clear it.
2. Add Songs.    Press the button labeled Add.    A dialog will appear listing all of the songs in
the current directory.    To select a single song, highlight it in the list and press Ok..    To 
select multiple songs, click on the first file to select, then drag to the last to be added, then 
press Ok.
Each file's name and the time length will appear in the album.    Note also that the total 
time length of the album appears just above the song listing.    This album length can 
incorporate a time delay between songs.    To change the length of this delay, see the 
Options Delay command.
Playing the Album
Now that we have an album of songs, we can press the green Play button and WinJammer 
Player will start to play them in sequence.    Don't be alarmed if the Player suddenly 
disappears when you press Play.    This is so that you can go and do other things while it 
plays.    This is controlled by the Minimize switch on the Options menu.
Stopping Play
Play will stop at the end of the album unless the Loop switch is used.    Play can be stopped 
by pressing the Stop button, or selecting Stop from the system menu.



Commands
This index contains a list of the Help available on the various WinJammer Player 
Commands.    For information on how to use Help, press F1 or choose Using Help from the 
Help menu.
File Menu Create, Load or Save Albums.
Edit Menu Add or Delete songs.
Options Menu Change WinJammer Player Options.
Main Window Work with an Album.



Keys
The following keys may be used as short cuts for various commands.
F1 Help
Ctrl+O Open a New Album.
Ctrl+S Save the Current Album
Ctrl+A Save the Album after Asking for a File Name
Del Delete the Selected Song
Ins Insert a New Song



Registration
As discussed in the index, WinJammer is being distributed as Shareware.    This allows you 
to evaluate the program to see if it performs properly, before you are obligated to pay for 
it.    It does not allow you to "evaluate" the program forever - if you use it for more than 30 
days, then you must register.
To register WinJammer send us a note and a cheque or money order for $50 US.    Please 
include in your note your name, mailing address, current version number and 
computer/MIDI setup.    The current version information is found in the Help About dialog 
box.    If you would like a copy mailed to you, please add an additional $5, and we will 
send you the most recent version available.    Please note that registration for WinJammer 
includes registration for WinJammer Player.
When we receive your cheque, we will send you a letter containing your personal 
registration code, and a diskette if you paid for one.    Use the File Register command to 
unlock the program.    If you have a CompuServe or Internet account, and include your id, 
and we will send the registration code via electronic mail.    Otherwise, we will have to send 
you an old fashioned letter.
We can be reached at:

WinJammer Software Limited
69 Rancliffe Road
Oakville, Ontario
Canada
L6H 1B1
Phone: (905) 842-3708
Fax: (905) 842-2732
CompuServe: 72662,3021
Internet: 72662.3021@CompuServe.com

Please ensure that you use the correct postage.    It currently costs 40 cents to mail a letter 
from the US to Canada.    A number of people have had their letters returned because of 
insufficient postage.

Registration on CompuServe
If you have a CompuServe account, you can also register online.    Type GO SWREG at any 
CompuServe prompt and select product number 119.    The registration fee will 
automatically be added to your CompuServe bill.    If you don't have a CompuServe 
account, we urge you to get one.    Please see the CompuServe topic for more information 
and an exciting free offer!
You will receive mail on CompuServe, containing your registration information.    The most 
recent version of WinJammer can always be found in the WinJammer section of the MIDI 
Vendor Forum on CompuServe, in library 16.    Just GO WINJAMMER to get there!

Parker Adams Group
Our friends at the Parker Adams Group will be pleased to accept registrations for 
WinJammer.    They accept Visa, Mastercard and Discover Card, as well as cheques.    The 
Parker Adams Group is also a distributor for WinJammer Professional, and will be happy to 
upgrade you from WinJammer to WinJammer Professional, or accept an order for 
WinJammer Professional.
The Parker Adams Group can be reached at:

The Parker Adams Group
Suite 124



12335 Santa Monica Blvd.
Los Angeles, CA    90025    USA

Call the Parker Adams Group between 9:00am and 5:00pm Pacific Time at (310) 450-2175, 
or Fax anytime at (310) 450-8526.    Remember to include a return phone number if you 
send a FAX, just in case there are any questions.

P. & A. Shareware Distribution
If you are in Japan, you can register through P. & A. Shareware Distribution.    Registration 
through P. & A. costs 7,500 Yen, including tax, basic setup information in Japanese and 
shipment of the latest version available on diskette.    They will accept orders by telephone, 
mail or FAX.    They also accept Visa, Mastercard, American Express and DC credit cards.    
Contact them at:

P. & A.
302 Bellwins, 1367-23
Nakagami, Akishima
Tokyo, 196 Japan
Tel: 0425-46-9141
Fax: 0425-46-9142
NiftyServe: PAF02461

Support
There are a number of channels that you can use to contact us.    The best method is via 
CompuServe - simply GO WINJAMMER to find us.    If you don't have a CompuServe account,
we can fix that - see the CompuServe topic for a free introductory offer!
The CompuServe ID for WinJammer Software is 72662,3021.    Internet users can send mail 
to 72662.3021@compuserve.com.
We can also be reached by telephone at (905) 842-3708 between the hours of 1 and 5 PM, 
Eastern Time.    You can also FAX (905) 842-2732 anytime.



WinJammer Professional
WinJammer has a new big brother - WinJammer Professional.    It's full of new editing 
features like Humanize, Swing, and Controller Fill to name a few.    It's got a beautiful 200 
page manual complete with easy to understand tutorials.    And, it supports Wave Files, 
SMPTE, and MCI Events.
See for Yourself!
If you'd like to see for yourself, there's a demo version of WinJammer Professional available 
for downloading on CompuServe.    Simply GO WINJAMMER and look for the file WJPRO.ZIP in
Library 16.    A demo version is also available by contacting The Parker Adams Group in Los 
Angeles at 310-450-2175 (see the Registration topic for the address).
So, Exactly What Are These New Features?
WinJammer Professional is big and powerful.    Check out the following list of features and 
we think you'll agree that WinJammer Professional is a world class sequencer program.    
Here's a detailed list of the differences between WinJammer 2.30 and WinJammer 
Professional.

User Manual and Reference
WinJammer Professional comes with a 200 page User's Guide and Reference Manual.    The 
User's Guide contains easy to understand tutorials that'll show you how to get the most out
of WinJammer.    The tutorials will show you how to take a simple tune and create a fully 
orchestrated song from it.    The Reference manual contains a complete reference to all 
aspects of the program, with pictures of the actual screens and examples.
Piano Roll
WinJammer Professional's Piano Roll window allows you to select one or more events for 
editing.    You can drag groups of notes around easily using the mouse.    You can "circle" a 
group of notes with the mouse to select them.    Just like WinJammer, you can also draw 
(create) new notes on the screen.
Event List
This window now allows for groups of events to be selected and edited.    It now shows the 
names of each program change event, and the name of each controller.    It also supports 
the new MCI and Wave events.
Track List
This window looks much the same as WinJammer.    It shows the names of each patch, and 
lets you easily change any of the fields by simply typing the new value into the field.    An 
important difference is that the Track List window lets you select a group of tracks instead 
of just a single track.    This makes it easy to make a change to a number of tracks at once!
Toolbar
The toolbar looks much like WinJammer's, with some important additions.    The toolbar 
allows you to set up a From/To region of the song.    This region is used for punch in 
recording and for limiting the effects of changes to just a region of the song.    You can also 
easily change the current position of the song using these From/To times.
Audition Patches
This window looks the same as in WinJammer.    An important distinction between the two 
programs is that WinJammer Professional allows you to create your own patch name set, 
and includes support for banked devices such as the Roland Sound Canvas (GS).    This lets 
you easily select all 300+ sounds available from your Sound Canvas!
Song View



This is a new window which shows you an overview of the song tracks at a glance.    It lets 
you easily see where there is data in a track at any point in the song.    It also lets you 
cut/copy/paste measures on one or more tracks.
Step Record
This is another new window.    It lets you step record - enter a song one note at a time.    You
can use either your external MIDI keyboard, or the built in Keyboard window.    It's easy to 
use and very versatile.
Keyboard
This window is both fun and practical.    It shows a MIDI keyboard on the screen which you 
can play notes with the mouse.    It'll transmit on any channel or port, with any velocity you 
choose.    You can even resize it, or change the number of keys that are triggered (ever 
wanted a 128 key MIDI keyboard?).    It's the perfect companion for the Step Record window
- you can use it to "play in" step recorded notes.
Swing Command
This is a new command that adds "swing" to your tracks. Besides being a useful command, 
it's also fun to experiment with different amounts of swing.
Humanize Command
This command lets you make a step entered or hard quantized song sound better.    It'll 
adjust the event start time, note length or note velocity.    It's surprising the difference it 
makes!
Controller Fill
If you've ever wanted to gradually change the volume or the tempo over several measures,
then you'll enjoy using this feature.    All you do is enter the start and end times and values,
and away it goes.    Use it on volume, velocity, tempo, pitch bend or any controller!
Quantize
Upgrade to WinJammer Professional and you can use the improved "quantize by 
percentage" feature to make your tracks sound tighter without losing the "feel" of your 
music.
Powerful Editing
You can now select in three different ways: Entire Tracks, All Events Between Two Points, or 
Just The Events You Select.    Virtually all the new powerful editing commands let you 
change just the events you've selected. Commands like Quantize, Humanize, Swing, 
Transpose, Transform, etc., let you choose which section of the track(s) to work on.    The 
result is unparalleled power!
Wave & MCI Events
WinJammer Professional plays Wave Files! And, you can control any MCI device from inside 
the song.    These features allow you to incorporate vocal recordings or sound effects (Wave
Files) and the various MCI triggered events into your songs!    The version of the WinJammer
Player program which comes with WinJammer Professional also supports Wave and MCI 
events!
SMPTE Support
WinJammer Professional supports SMPTE sync.    It'll work with cards such as the Music 
Quest MQX-32M to operate in a SMPTE environment so you can hook up to tape recorders, 
etc.

WinJammer Professional carries a list price of $199.95 US.    Registered WinJammer users 
can upgrade for the special price of $129.95 US.    For full details and current pricing, 
please contact the Parker Adams Group at:



The Parker Adams Group
Suite 124
12335 Santa Monica Blvd.
Los Angeles, CA    90025    USA
Phone: (310) 450-2175
Fax: (310) 450-8526



CompuServe®
CompuServe gives you a direct line to WinJammer Software Ltd.
The WinJammer section in the MIDI B Vendor Forum is the best spot to get answers to any 
question you may have about any WinJammer Software product.    You can get:
* Assistance on any technical problems you may have
* News on new products and upgrades
* Demonstration versions of software
You can talk directly to us at WinJammer Software.    You can also talk with the thousands of 
other users of WinJammer Software products among CompuServe's over 1.6 million 
international membership.    The WinJammer section is your gateway into all of the other 
services available on CompuServe.
The WinJammer Forum lets you:
* Get Technical: tell us about any technical problems you're having.    We'll do our best to 

get you fixed up quickly, and make sure you're happy.
* Make Suggestions: tell us what you'd really like to see in the next release.    What 

features are great?    What's bad?    We want to know!
* Check the Library: the latest version of WinJammer is always found in the WinJammer 

library on CompuServe.    Always.    The library also has press releases, demonstration 
versions of WinJammer Professional or other software.

CompuServe is much more...
The WinJammer section of the MIDI B Vendor Forum is your window to the body of 
additional services available on CompuServe.    Many services complement specific 
applications.    Others add a new dimension to business endeavors.    Still others cater to 
personal interests, from aviation to Zinfandel wines.
* Invest Wisely.    Speed stock purchases and sales with convenient electronic brokerage 

services.    View stock trends online, research investment possibilities, or transfer data 
from CompuServe for use in your favorite spreadsheet package.

* Take a trip.    Compare airline schedules and fares on CompuServe.    Find the least 
expensive flight or the best time to fly.    Book your tickets online, or pass information on 
to your travel agent.

* Do your homework.    Turn hours of research into minutes online, with hundreds of 
national and international databases representing diverse specializations.    Avoid lengthy 
library searches by pulling up abstracts and full articles directly online.

* Be informed.    Turn to CompuServe's online news services daily for news from the 
Associated Press' national and international wires, United Press International's national, 
international and regional wires, The Washington Post, Reuters and other reputable 
sources.    The Executive News Service scans these wires for articles on topics you select, 
then clips and saves them for reading at your leisure.

Don't pass this up.
As a WinJammer customer, you are entitled to a free Introductory Membership to 
CompuServe, including:
* FREE access to all of CompuServe's Basic Services for one month,
* a $15 introductory usage credit to explore the WinJammer section of the MIDI B Vendor 

Forum and CompuServe's other Extended and Premium Service offerings,
* a private User ID Number and Password
* a complimentary subscription to CompuServe Magazine, CompuServe's monthly 

computing publication.



Start connecting with WinJammer and other CompuServe members by calling one of the 
following numbers.
Australia Freephone: 008 025 240 Direct: (+61) 2-410-4260
France AZUR phone: 36-63-81-22 Direct: (+33) 1-47-14-21-65
Germany Freephone: 0130 37 32 Direct: (+49) (89) 66 535-111
New ZealandFreephone: 0800 446 113Direct: (+61) 2-410-4260
UK Freephone: 0800 289 378Direct: (+44) (272) 760681
U.S. Toll Free: 800-524-3388 Direct: (+1) 614 529-1349
Elsewhere Direct: (+1) 614 529-1349
Be sure to ask for Representative #232
If you are already a CompuServe member, enter GO WINJAMMER at any ! prompt to access 
the WinJammer section of the MIDI B Vendor Forum on CompuServe.
We look forward to seeing you online!



File Menu
The File menu includes commands that enable you to load or save albums, or create a new 
album.    To WinJammer Player, an album is a list of the songs that you would like played.
For more information about a File Menu command, select one of the following topics.
New Create a New Album.
Open Loads an Album File.
Save Saves the Current Album.
Save As Saves the Album under a Different Name.
Configure Configures the MIDI Device.
Exit Exits WinJammer Player.



Edit Menu
The Edit menu includes commands that enable you to add or delete songs from the album.
For more information about an Edit Menu command, select one of the following topics.
Insert Song Insert a song at the end of the Album.
Delete Song Deletes the selected song from the Album.



Options Menu
The Options menu includes commands which effect the operation of WinJammer Player.    All
of these options are stored when you exit so that next time you use WinJammer Player you 
do not have to customize WinJammer Player again.
For more information about one of the Options Menu commands, select one of the following
topics.
Auto Reset Send Reset Commands between songs.
Minimize Turn into an Icon when Playing.
Delay Set a delay between songs.
Advanced Adjust advanced MIDI parameters.



Main Window
The Main Window contains the controls used to manipulate an album of songs, along with 
the controls which control the playback.
There are five colored buttons across the top of the window.    Moving from left to right, 
these are:
Prev Song Skip to Previous Song.
Play Start the Album Playing.
Stop Stop the Playback.
Pause Pause the Playback.
Next Song Skip to Start of Next Song.
On the right side, there are two buttons and two switches.
Add Song Add a Song to the Album.
Loop Delete a Song from the Album.
Shuffle Play the songs in a random order.
Reset Send a reset sequence.



File New Command
The File New command is used to clear the current album from memory.    It deletes all 
songs from the album, and reinitializes the system to its start up state.
If you have not saved the last changes you made to the current album, WinJammer Player 
will ask you if you would like to save them before clearing the album.



File Open Command
The File Open command is used to load an album from disk.    It replaces the current album 
in memory.
If you have not saved the last changes you made to the current file, WinJammer Player will 
ask you if you would like to save your changes before loading the new album.
Short Cut Key: Ctrl+O



File Save Command
The File Save command saves the current album using the current file name.    If there is no
current file name, the File Save command is the same as the File Save As command.    If a 
song was previously named using the File Save As command or if the file was loaded using 
the File Open command, then the file on disk is overwritten by the album.
Short Cut Key: Ctrl+S



File Save As Command
The File Save As command saves the current album, after prompting for a file name.    If the
entered file name exists, WinJammer Player will prompt before overwriting the file.
Short Cut Key: Ctrl+A



File Configure Command
This command is used to configure WinJammer Player for the hardware on your particular 
machine.    You must do this before you can play or record.
The dialog box displayed is used to select the devices to be used.    The list of available 
devices will depend on the drivers you have installed.    Simply select the desired input and 
output devices, then press Ok.    It is possible to reconfigure WinJammer Player whenever 
you choose.
Control Panel
The Windows Control Panel application is used to configure Windows for your equipment.    
There are two steps required to set up MIDI devices.
1. Install the drivers: The first step is to install drivers for your hardware.    This is done 
through the Drivers icon in the Control Panel.    When first started, you will be presented 
with a list of the installed drivers.    Press the Add button to add more drivers to the list.    
Depending on the driver, you may be asked for the hardware configuration information.    
Once all of the drivers are added, you will have to restart Windows to make the new drivers
available.
2. Configure the MIDI Mapper: The MIDI Mapper is a special MIDI output device that is 
used to remap songs from the General MIDI Specification to whatever equipment you have. 
You can start the MIDI Mapper by clicking on the icon in the Control Panel.    The dialog 
shown will allow you to select your setup from one of the defaults.    If you get a message 
saying that the current setup references a device that you don't have installed, then you'll 
have to either edit the configuration or choose a different one.    See your Windows manual 
for more details.
WinJammer MIDI Configuration
Now that the proper devices are installed, you can use the File Configure command to 
select the appropriate input and output device.    Note that the MIDI Mapper is sometimes 
slow.



File Exit Command
The File Exit command will terminate WinJammer Player, and return to Windows.    If the last
changes to the current album have not been saved, WinJammer Player will ask if you would
like to save them before exiting.



Edit Insert Song Command
The Edit Insert Song command is used to add one or more songs to the end of the album.    
It can be invoked three different ways - by pressing the Add button on the main window, 
pressing the Insert key on the keyboard, or by selecting it off the Edit menu.
In the dialog that appears, simply click on the song to add, then press Ok.    If more that one
song is to be added, simply click on the first song, and drag to the last song, or press the 
Ctrl key down when you click on a song to select it.
Short Cut Key: Ins



Edit Delete Song Command
The Delete Song pushbutton is used to delete the currently selected songs.    Remember 
that WinJammer Player does not change the actual song files - they will still exist on the 
disk.    All that is deleted is the reference to the song in the album.
Short Cut Key: Del



Options Auto Reset Switch
The Auto Reset switch is used to tell WinJammer Player to send out a reset sequence at the 
end of each song.    This can be very useful if a song changes a controller, and the following
song doesn't reset it.
The actual reset sequence is stored in the SETTINGS.INI file, which should be in the same 
directory as the program.    For information on this file, refer to the MIDI Auto Reset switch 
in WinJammer Professional, and appendix B in the manual.



Options Minimize Switch
The Minimize switch is used to ask WinJammer Player to minimize (turn into an icon) 
whenever playback is started.    This is handy when you are playing a number of songs in 
the background.



Options Delay Command
The Delay command is used to set up a time delay between songs during playback.
The dialog which appears allows you to set a delay between songs in seconds.
The total time length of the album is adjusted to take this delay time into account, so it 
remains accurate.



Options Advanced Command
This dialog contains a number of "advanced" switches used to control WinJammer Player's 
behavior.    Under normal circumstances, these switches do not need to be used.
Thru Mode
This section of the dialog allows you to select the port number to be used for MIDI Thru, 
and enable or disable Thru echoing.    Refer to the File Configure dialog to determine the 
port number.
Chase Controllers
The Chase Controllers switch causes WinJammer to output all non-note event messages 
that occur before the starting playback position.    This allows Sysex messages, as well as 
other non-note events that configure your devices, to be sent even though you are starting 
playback from the middle of a song.    Normally this should always be enabled.
Timer Resolution
This value defines the highest frequency that the computer's clock is to be run.    Under 
normal circumstances, this should be left at the default of 5 msec (200 times per second).    
A higher value will cause the clock to occur less often, causing a lower overhead and better
overall performance in Windows.



Previous Song Button
This command causes the currently playing song to be stopped immediately.    If there is a 
song before the current one in the album, playback will start again with this previous song.
The system menu (pull down from close box or clicking on Icon) includes this command.    
This makes it easy to skip to the previous song while the album is playing in the 
background.



Play Button
This command will start the playing of the current album.    Playback starts with the 
currently selected song, or the first song in the album.
The system menu (pull down from close box or clicking on Icon) includes this command.    
This makes WinJammer Player easy to control when it is minimized.



Stop Command
The Stop command stops the play of the album immediately.
The system menu (pull down from close box or clicking on Icon) includes this command.    
This facilitates shutting down Windows while an album is playing.



Pause Command
The Pause command stops the play of the album immediately.    The next time that Play is 
pressed then the playback of the current song will continue.
The system menu (pull down from close box or clicking on Icon) includes this command.    
This is often convenient when running WinJammer Player minimized.



Next Song Command
The Next Song commands causes the currently playing song to be stopped immediately.    If
there is another song in the album, the album will continue playing with this next song.
The system menu (pull down from close box or clicking on Icon) includes this command.    
This makes it easy to skip to the next song while the album is playing in the background.



Loop Switch
The Loop switch specifies what WinJammer Player is to do at the end of the album.    If this 
switch is on (checked), playback will start again with the first song in the album.



Shuffle Switch
The Shuffle switch allows you to request that the selected songs be played in random order.
Note that the same song entry will never be played twice in sequence while this switch is 
on (checked).



Reset Button
The Reset button is used to send a reset sequence out to all MIDI devices.    This button only
works when the album is not playing.
The actual reset sequence is stored in the SETTINGS.INI file, which should be in the same 
directory as the program.    For information on this file, refer to the MIDI Reset command in 
WinJammer Professional, and appendix B in the manual.




